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                                                                        With the Turn Google Slides into PDF feature, you can easily convert your dynamic presentations into PDF documents, ensuring that they are accessible and viewable by anyone, anywhere, and on any device. This powerful tool offers a range of benefits that will enhance your presentation experience and simplify your workflow.

                                                                                                Key Features:

                                                                                                
                                                                    
                                        Seamless Conversion: Effortlessly transform your Google Slides into high-quality PDF files with just a few clicks.

                                    

                                                                    
                                        Preserve Formatting: Retain the original layout, formatting, and graphics of your presentation to ensure it looks professional and polished.

                                    

                                                                    
                                        Customizable Options: Tailor your PDFs by choosing specific slides or the entire presentation to convert, making it easy to share only the relevant content.

                                    

                                                                    
                                        Offline Accessibility: Enjoy the convenience of accessing your presentation without an internet connection, as PDF files can be easily viewed offline.

                                    

                                                                    
                                        Enhanced Compatibility: PDFs can be opened and viewed on any device or operating system, eliminating compatibility issues and ensuring seamless sharing and collaboration.

                                    

                                                                    
                                        Cross-Platform Integration: Integrate the Turn Google Slides into PDF feature with other productivity tools and platforms for a more streamlined workflow.

                                    

                                                            

                                                                                                Use Cases and Benefits:

                                                                                                
                                                                    
                                        Efficient Collaboration: Easily share PDF versions of your presentations with colleagues, clients, or stakeholders who may not have access to Google Slides. This allows for efficient collaboration and ensures that everyone can view and comment on your work.

                                    

                                                                    
                                        Portability and Versatility: PDFs are portable and can be easily shared via email or other messaging platforms. They can also be printed or displayed on screens of any size without compromising the quality of the content.

                                    

                                                                    
                                        Presentation Backup: Convert your Google Slides into PDF format to create a backup copy, providing an additional layer of security for your presentation files.

                                    

                                                                    
                                        Professional Documentation: Turn your Google Slides into PDF files to create professional and visually appealing documentation of your presentations, perfect for sharing on websites, portfolios, or promotional materials.

                                    

                                                                    
                                        Easy Distribution: Distribute your presentation materials to a wider audience by converting them into PDF format, as PDFs are widely accepted and can be easily distributed through various channels.

                                    

                                                                    
                                        Accessibility Compliance: Ensure that your presentations meet accessibility standards by converting them into PDF format, which is compatible with assistive technologies and provides accessible content for users with disabilities.

                                    

                                                            

                                                                                                Experience the convenience, flexibility, and compatibility of the Turn Google Slides into PDF feature, empowering you to showcase your presentations effectively and effortlessly!

                                                            

            

        

    
    
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
            

            
                                    
                        Start free trial
                    
                            

            

            

        

    


                                                
            
                    
        How to Turn Google Slides into PDF online with ease
    


            Every file format we know in today’s modern world has particular characteristics for solving different tasks. Some are more edit-friendly and agile, while others allow sharing and safeguarding the data they contain. The real problem comes when you must turn one format to another, in your case Turn Google Slides into PDF, without compromising the file’s quality.

                The task is to Turn Google Slides into PDF is more straightforward if you use the right tool. pdfFiller is the option you’re looking for. It’s easy for inexperienced people and power users and allows anyone to transform files into any desired format in minutes.

                Five simple steps to Turn Google Slides into PDF online in minutes

                
                        
                                    01

                    
                        Create your pdfFiller account or sign in to an existing one.
                    

                            

                        
                                    02

                    
                        Hit Add New to add a new document and select the import or upload option.
                    

                            

                        
                                    03

                    
                        If your document needs editing, select Start editing to open it in the editor.
                    

                            

                        
                                    04

                    
                        Click the Go to My Docs button if you want to skip editing, and simply save the document in the My Docs tab.
                    

                            

                        
                                    05

                    
                        Choose the Try a template option to convert your document into a template created for repeated use.
                    

                            

                        
                                    06

                    
                        Click Work on the doc → then click on the uploaded document → and choose Save as on the right sidebar to Turn Google Slides into PDF.
                    

                            

                        
                                    07

                    
                        Pick the desired output format and select you want to save/download the file.
                    

                            

                    

                Since pdfFiller is a cloud-based solution, you can access your added document anytime and continue editing it. In addition, pdfFiller lets you work and manage your files and enables you to edit, annotate, safeguard and author and eSign documents from the convenience of your laptop or mobile phone.

                Converting files from one format to another and vice versa is easier than ever with options like pdfFiller. Sign up for a free trial now!
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        How to Turn Google Slides into PDF with pdfFiller
    


            Converting your Google Slides into PDF format is a breeze with pdfFiller. Follow these simple steps to make the most out of this feature:

                
                        
                                    01

                    
                        Open pdfFiller and log in to your account.
                    

                            

                        
                                    02

                    
                        Click on the 'Google Drive' tab on the left-hand side of the screen.
                    

                            

                        
                                    03

                    
                        Select the Google Slides presentation you want to convert into a PDF.
                    

                            

                        
                                    04

                    
                        Once the presentation is open, click on the 'More' button located at the top-right corner of the screen.
                    

                            

                        
                                    05

                    
                        From the drop-down menu, choose the 'Convert to PDF' option.
                    

                            

                        
                                    06

                    
                        pdfFiller will start processing the conversion. This may take a few moments depending on the size of your presentation.
                    

                            

                        
                                    07

                    
                        Once the conversion is complete, you will be prompted to save the PDF file. Choose a location on your computer or cloud storage to save the file.
                    

                            

                        
                                    08

                    
                        Congratulations! You have successfully turned your Google Slides into a PDF using pdfFiller.
                    

                            

                    

                With pdfFiller's Turn Google Slides into PDF feature, you can easily share your presentations in a universally compatible format. Whether you need to send it via email, upload it to a website, or print it out, the PDF format ensures that your slides will look exactly as intended. Give it a try and experience the convenience of pdfFiller today!

            

    
                
    
        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:
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                            4,6

                        

                        9k Reviews

                    

                

        

                    
                                    
                        
                            
                                
                                    Raul Z

                                    

                                

                                
                                    2016-07-24

                                

                            

                            
                                
                                    Works great with laptop, but Was time consuming and difficult to work on IPad. Had to switch to my laptop in order to speed up the process and complet the job.
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                                    Valerie

                                    

                                

                                
                                    2016-10-16

                                

                            

                            
                                
                                    I like it, but I do want to use the same form and just change a name and date of birth for a sibling. Can I do that or do I have to fill out the same form all over again?
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play
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                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


    
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
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            Related searches to Turn Google Slides into PDF

            
                                    how to convert google slides to pdf on iphone

                                    how to convert google slide to pdf on ipad

                                    how to save google slides as pdf on phone

                                    how to save google slides with notes as pdf

                                    how to convert google slides to powerpoint

                                    how to save a single powerpoint slide as a pdf

                                    how to save one slide in powerpoint as jpeg

                                    how to save one slide from powerpoint

                                    how to save powerpoint as pdf with multiple slides per page

                                    how to convert powerpoint to pdf on mac

                                    how to convert google slides to powerpoint without losing formatting

                                    how to convert google slides to powerpoint with audio

                                    how to convert google slides to powerpoint on mac

                                    how to export slides from google slides

                            

        

    
        
    
        
            List of extra features
        

        
                            
                    Switch PDF to OneNote
                

                            
                    Switch PDF to OpenOffice
                

                            
                    Switch PDF to Outlook Email
                

                            
                    Switch PDF to Pages
                

                            
                    Switch PDF to Photo
                

                            
                    Switch PDF to Picture
                

                            
                    Switch PDF to PNG
                

                            
                    Switch PDF to Poster
                

                    

    


        
        
            
                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How do I convert slides to files?
                        

                                                    Download a PPT from Google Slides. Open the Google Slides presentation in a web browser. From the top menu, select File > Download. Select the Microsoft PowerPoint option from the list of file types.

                                            

                                    
                        
                            
Can you save a PowerPoint slide as a PDF?
                        

                                                    Printing and Saving as PDF If you choose Quick Print from the Quick Access Toolbar, you will skip the dialog box shown to the left, and it will default to printing the individual slides in color. To save as a PDF, go to File, choose Save As, and then choose PDF or XPS.

                                            

                                    
                        
                            
How do I save a single slide from Google Slides as a PDF?
                        

                                                    Exporting without Speaker Notes, One Slide per Page Click File → Download as → PDF document (. pdf).

                                            

                                    
                        
                            
How do I import a slide into a PDF?
                        

                                                    In PowerPoint, select the slide that you want to add the file to, and then select Insert > Object. In the Insert Object box, select Create from file, and then enter the PDF file location. or, click Browse, find the PDF file, and then select OK.

                                            

                                    
                        
                            
Can you turn a Google slide into a PDF?
                        

                                                    Save Google Slides as a PDF on the web Step 1: With your presentation in view, select File from the menu. Step 2: Move your cursor to Download and pick PDF Document (. pdf) in the pop-out menu. Step 3: The file will download immediately.

                                            

                                    
                        
                            
Can you save a slide as a PDF?
                        

                                                    Printing and Saving as PDF To save as a PDF, go to File, choose Save As, and then choose PDF or XPS. Settings: Slides: This is where you can choose to print all slides, one slide, or a custom range of slides (type the range of slides in the box underneath).
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                Sign, send for signature, and track documents in real-time with signNow.
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            Country
            Select your country
Afghanistan
Åland Islands
Albania
Algeria
American Samoa
Andorra
Angola
Anguilla
Antarctica
Antigua & Barbuda
Argentina
Armenia
Aruba
Australia
Austria
Azerbaijan
Bahamas
Bahrain
Bangladesh
Barbados
Belarus
Belgium
Belize
Benin
Bermuda
Bhutan
Bolivia
Bosnia & Herzegovina
Botswana
Bouvet Island
Brazil
British Indian Ocean Territory
British Virgin Islands
Brunei
Bulgaria
Burkina Faso
Burundi
Cambodia
Cameroon
Canada
Cape Verde
Caribbean Netherlands
Cayman Islands
Central African Republic
Chad
Chile
China
Christmas Island
Cocos (Keeling) Islands
Colombia
Comoros
Congo - Brazzaville
Congo - Kinshasa
Cook Islands
Costa Rica
Côte d’Ivoire
Croatia
Cuba
Curaçao
Cyprus
Czechia
Denmark
Djibouti
Dominica
Dominican Republic
Ecuador
Egypt
El Salvador
Equatorial Guinea
Eritrea
Estonia
Eswatini
Ethiopia
Falkland Islands
Faroe Islands
Fiji
Finland
France
French Guiana
French Polynesia
French Southern Territories
Gabon
Gambia
Georgia
Germany
Ghana
Gibraltar
Greece
Greenland
Grenada
Guadeloupe
Guam
Guatemala
Guernsey
Guinea
Guinea-Bissau
Guyana
Haiti
Heard & McDonald Islands
Honduras
Hong Kong SAR China
Hungary
Iceland
India
Indonesia
Iran
Iraq
Ireland
Isle of Man
Israel
Italy
Jamaica
Japan
Jersey
Jordan
Kazakhstan
Kenya
Kiribati
Kuwait
Kyrgyzstan
Laos
Latvia
Lebanon
Lesotho
Liberia
Libya
Liechtenstein
Lithuania
Luxembourg
Macao SAR China
Madagascar
Malawi
Malaysia
Maldives
Mali
Malta
Marshall Islands
Martinique
Mauritania
Mauritius
Mayotte
Mexico
Micronesia
Moldova
Monaco
Mongolia
Montenegro
Montserrat
Morocco
Mozambique
Myanmar (Burma)
Namibia
Nauru
Nepal
Netherlands
New Caledonia
New Zealand
Nicaragua
Niger
Nigeria
Niue
Norfolk Island
North Korea
North Macedonia
Northern Mariana Islands
Norway
Oman
Pakistan
Palau
Palestinian Territories
Panama
Papua New Guinea
Paraguay
Peru
Philippines
Pitcairn Islands
Poland
Portugal
Puerto Rico
Qatar
Réunion
Romania
Russia
Rwanda
Samoa
San Marino
São Tomé & Príncipe
Saudi Arabia
Senegal
Serbia
Seychelles
Sierra Leone
Singapore
Sint Maarten
Slovakia
Slovenia
Solomon Islands
Somalia
South Africa
South Georgia & South Sandwich Islands
South Korea
South Sudan
Spain
Sri Lanka
St. Barthélemy
St. Helena
St. Kitts & Nevis
St. Lucia
St. Martin
St. Pierre & Miquelon
St. Vincent & Grenadines
Sudan
Suriname
Svalbard & Jan Mayen
Sweden
Switzerland
Syria
Taiwan
Tajikistan
Tanzania
Thailand
Timor-Leste
Togo
Tokelau
Tonga
Trinidad & Tobago
Tunisia
Turkey
Turkmenistan
Turks & Caicos Islands
Tuvalu
U.S. Outlying Islands
U.S. Virgin Islands
Uganda
Ukraine
United Arab Emirates
United Kingdom
United States
Uruguay
Uzbekistan
Vanuatu
Vatican City
Venezuela
Vietnam
Wallis & Futuna
Western Sahara
Yemen
Zambia
Zimbabwe
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0 - 5 employees
6 - 50 employees
51 - 200 employees
201 - 1000 employees
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2001 +  employees
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